Pulsonix Vault

fecnotfron

Das beste Bauteil ist Erfahrung

Pulsonix Vault Installation und Evaluation

Die Vault ist ein Versionierungssystem fiir Pulsonix Daten. Sie bietet
Mehrwerte fur ECAD- und Bibliotheksdaten aus zusatzlich gewonnen Daten

an.

Installation

Um die Vault (Tresor) zu testen, gibt es eine Demo
Version, die auf einem Anwender PC lokal sehr einfach
installiert werden kann. Sie missen sich dazu nur die
Vault Funktion in lhrer Lizenz freischalten lassen und
das Tool installieren. Wenden Sie sich dafir an uns.

Die Installationsdatei VaultAdminSetup.exe sollte in der
aktuellen Version ausgefuhrt werden.

Pulsonix Vault Admin - Installshield Wizard X
PULSONIX
_N_

Choose Destination Location
Select folder where setup will install files.

Chaose the folder where the program files should be installed

Destination Folder

Erowse...

C:%Program Files (xB6]\Pulsonix: Yault Admin 10.5

Install5hield

<Back | HNew> § | Cancel |

Klicken Sie auf Next bis zu diesem Fenster, belassen
Sie den lokalen Speicherort, den der Installer vorschlagt
und flihren Sie das Setup bis zum Ende durch.

Danach kdnnen Sie die eigentliche Installation starten
indem Sie in das Verzeichnis C:\Program Files
(x86)\Pulsonix Vault Admin 10.5 wechseln und die
Installationsdatei VaultServerSetup.exe 6ffnen.

Hier wahlen Sie ,Install Demo Vault®:

Vault Server Setup x

—] Install a local Vault server pre-populated with sample data
| for evaluation of Vault features.

Install Vault Server | Inztall a Vault server and empty database ready for use with your
own production data.

— Pulsonix

Cancel |

An dieser Stelle ist noch zu erwahnen, dass die Option
Install Vault Server flr eine Installation ohne Demo
Daten bendtigt wird und auf einem Windows 201X
Server installiert werden muss. Hierzu gibt es eine
Anleitung in Pulsonix unter Help > Online Manuals >
Vault Users Guide.

Mit ,Install now..“ starten Sie den Installationsprozess
und es werden alle nétigen Schritte, im Gegensatz zu
der Serverinstallation, automatisch ausgefihrt.
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1 Vault Demo Setup X

This Setup will install the database server, create a new Pulsonix Vault database, and populate
it with example design and library data to make it easy for you to see how the Vault works.

Install Now... Options... |

\/ Install and launch Postgres database server
v Create Pulsonix Vault database

v Create data file folders

" Share data file folders

\/ Restore sample Vault data

\/ Installation complete

—— Pulsonix

Ein Klick auf Options.. zeigt die Login Daten fir den
Datenbankserver, falls Sie sich den Inhalt der
Datenbank (PostgreSQL) anschauen wollen.

Optigns x

W iInstall PostgreSQL Database Server

Postgres Role Mame: I postgres

Postgres Password: I password

Vault Files Folder: I C:\Wsers\Public\Documents \Pulsonix 10, 5\WaultDemo

Shared Folder Name: I YWMbws 16\PulsonixVault

o]

Cancel |

Die bendtigten ODBC Treiber fir die Kommunikation mit
der Datenbank sind jetzt auch schon installiert.

SN=N=g=

Jetzt kdnnen Sie sich in Pulsonix im Vault Setup unter
»3ign In“ in der Vault anmelden. Der User Name ist
»=admin® und das Password ist ,password“. Bei einer
erfolgreichen Verbindung mit , Test® kommt eine
Meldung, dass die Verbindung erfolgreich war.

ault Setup — Sign In

SignIn  Users Groups Revision Maming  Attributes  Options  Calours

(®) Primary Sign-n () Atemate Signin
User Mame: ‘admin | ‘ |
Password ‘password | ‘ | Show
ODBC Diver: | PostareSGL ANSI | [ Defauk
Server Name ‘Iocalhost |
Seer o Pulsoni x

Test

Data Folder: ‘\\was16\PuIsonixVault\ﬁIes\ | Vault successfully connected
Vauit 1D [132300431053180000

|

Bevor Sie Designs auschecken sollten Sie noch im
Vault Setup einen Check out Item Library Folder
angeben. Dort werden die ausgecheckten Designs
temporar gespeichert.

Vault Setup — Options X

Signin Users Groups Revision Naming Attrbutes OPtions  Colours
Database Setings
Referenced ftems when Checcin Library tems Abbrechen
O Must be from the Vauit
(® If not from the Vaut will be automatically linked using Name:
() Need ot be from the Vault Hife

0K

Dpemehmen

Referenced tems when Checkdn Design kems
O Must be from the Vaut

@ F ot from the Vault will be automatically linked using Mame (Library items versions must also match)
O Meed not be from the Vault

Vault Date Format: |DD-MM-YYYY {used inside database, so it applies to all Vault users)

Personal Settings
Folders

Transfemed Libraries Backup

[ [
[ Miror Viauk Foider

Browse
Checked Out Lbrary fem Folder
[DSuppor Lirares | [ Browse
Copied Out Library tem Folder
[ | [ Browse.

‘Show Vauk signin detalls on Status Bar [ Treat items from another Vauit as ewitems

Vault Manager Uberblick

Im Top Men sollten die Icons flr die Vault sichtbar sein,
mit denen Sie in den Manager oder auch ins Setup
kommen. Falls nicht lasst sich dieses Menu Uber
Customize > Toolbars einfiigen.

Offnen Sie den Vault Manager und navigieren Sie durch
die vorhandene Baumstruktur.

Vault Manager — Browser

Browser  |ibrariesto Vault Designsto Vault  Audit Trail Export Vault Libraries

Wault ltems:
BN item ID|
{73 Design Content
<23 Library Content
{73 Profies

=3 Technology Files

Wault Folders:

|Type ‘ Folder | Name ‘ Revision |

Diese Struktur kann spater individuell angepasst
werden. Sie kdnnen Ordner flr Bibliotheken,
Technologiefiles, Profiles oder auch fiir Designs
anlegen.

Iltem Detailansicht andern

Selektieren Sie ein Design in der Baumstruktur und
andern Sie die Detailansicht in der Auswahlliste. Sie
kénnen zwischen Audit Trail (eine Historie des
selektierten Items), Where Used (Information wo das
Item eingesetzt wird) und Refers To (Information welche
weiteren ltems dafir verwendet werden) wahlen.

I
kem Details: v ‘

temi|  [Type [action pate [Timestamp. [Revision [Action Type [Motes user Name|
157 Schemac Design 21-07-2017 18.06.14212 21072017 16.06.14212 10 | Added (wih automalc referencing) Added fo Vaul Demo iadmn |

Revision: [<Latest Revision> -
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Revisionsansicht des Iltems andern

Neben dem Feld Items Details befindet sich das Feld
»Revision®. Dort kdnnen Sie die Ansichten <Last
Revision> (letzte Revision, Default Einstellung), <All
Revisions> oder eine bestimmte Revision anzeigen
lassen.

Arbeiten mit der Vault

Aktivieren Sie die Vault fur Ihre Bibliothekspfade, indem
Sie die Folders 6ffnen.

Folders > Technologie: Setzen Sie den Eintrag bei Vault
auf Enable.

87 Folders - Profile Files 3

Folders and Search Order:
[Vau]
IC:\Users\mum\Documents \Psonix10.5\Profes

Add
Edt

Dekete
Folder Enabled

Folders > Profile: Setzen Sie auch hier den Eintrag bei
Vault auf Enable.

Folders > Libraries: Setzen Sie auch hier den Eintrag
bei Vault auf Enable.

Erstellen Sie mit File > New ein neues Schematic
Design und wahlen Sie eine Technologie und Profile File
welches direkt aus der Vault stammit.

MNew
Designs  Technologies + Profiles  \Wizards

. FCE Design

ermatic: D esign

Sem Hierarchy Block
Ej FCE Footprint

[E] PCB Doc Symbol
Schematic Syrmbal
Schematic Doz Symbal
@y Part

Parel Design

Technology: |Default (white - Irmperial]

Profile File: | A4-Landscape

Cancel

Danach sollten Sie eine leere Schaltplan Seite mit
einem Zeichnungsrahmen (Profile) sehen.

r B

Bauteile EinflUgen

Flgen Sie Bauteile in den Schaltplan ein indem Sie den
Befehl Insert > Components (in der linken
Werkzeugleiste) ausfihren.

B Ble Edit View Inset Set
iD=mEdMi&ISeld

—

Beim ersten Start des Dialogs steht im Feld Look In: All
Libraries. Andern Sie es in ,Vault only“. Danach sehen
Sie, dass die zu platzierenden Bauteile aus der Vault
angezeigt werden.

&7 Insert Component X

Look In: | RENNAETS| | (From vaul) Add
P
p | Nores[ ] [
Matched: 10 of 10 [ inchude Connectors
Pt e < P e

Dese: [Diode 1A | Faniys [

Footpint[D0-35 <]

Name: [01 ]

Sombot [F0ET 7 st Conoin 01

Number of Copies:[1 =

<Lt Fvirs 5

Sghemalic & PLB [ Atirbutes (7] Vault

Vait
Pat:

TN4148: 130 1.0 21:072017 17:57:00.370)
oolpiint

DO0-35:104 1.0 21-07-2017 17:55:35.939)

DIODE-1:1141.0 (21-07-2017 17:55:39.962)

_1N4148

Flgen Sie folgende Bauteile nach dieser Abbildung und
den folgenden Punkten aus lhrer Vault ein.

RASIACRACIATIOA SR ATRVAY

AL OUT

* Suchen Sie im Insert Component Dialog nach
dem Part CD4017BE. Fiigen Sie es mit Add hinzu.

» Suchen Sie im Insert Component Dialog nach
dem Part 1N148. Fligen Sie es mit Add hinzu.

» Tipp: Wenn Sie den Rechtsklickbefehl Insert
Multiple Items verwenden kdnnen Sie alle acht
Bauteile in einem Schritt platzieren und danach mit
der Taste R rotieren.

» Suchen Sie im Dialog nach CEI .
dem Part R 0.25W 5% MCF 10K I
und platzieren Sie ihn an der -

ReseT

linken Seite. Drucken Sie ESC,
um in den Dialog zurtick zu
gelangen. .
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* Suchen Sie im Dialog nach dem Part R 0.25W 5%
MCF 330 und platzieren Sie es unten rechts.

| ‘ -

« Um das letzte I
suchen Sie nach it
2N222 oder Sie

Part
hinzuzufiigen, s e @
tippen es in das

Part Feld ein und platzieren es unten rechts.

Fugen Sie Signal Referenzen tber Insert > Signal
Reference ein. Stellen Sie sicher das auch in diesem
Dialog bei Look In: Vault Only steht. Platzieren Sie die
Docsymbole GND links, +5V rechts im Design.

Verbinden Sie anschlieend die einzelnen Iltems mit
einem Doppelklick auf die Pins (Alternativ Insert >
Connection).

Check In des Designs

In dem Beispiel Design, dass wir gerade erstellt haben,
klicken wir nun auf das Filemen( > Check into Vault.

Check Into Vault >

Vault Revision: I:'

Mame: | Vault Design |

Default Mext Vault Revision

Vault Folder

| \Design Content | Browse...

Check In Note

Erster Check In des Vault Designs

] remove item from local folder after Check In

Cancel

Vergeben Sie einen Namen. Der Vault Folder ist der
Speicherort in der Baumstruktur der Vault. Fliigen Sie
bei Check In Note eine Nachricht, Uber das Design ein.
Bestatigen Sie mit OK. Danach ist das Design in der
Vault verfligbar.

Hinzufugen von Items in die Vault

In diesem Abschnitt geht es darum ein Item in die Vault
hochzuladen, dass bisher noch nicht in der Vault
existiert.

Es wird ein SMD Resistor in die Vault eingefugt. Weil
bereits ein passendes Symbol in der Vault vorhanden ist
wird nur noch ein Part und ein Footprint bendtigt.

SM0603 Footprint hinzufligen:

Aktivieren Sie im Library Manager > Folders den Pfad
C:\Users\Benutzer\Documents\Pulsonix10.5\MasterLibr
aries. Wechseln Sie danach den Tab PCB Footprints
und selektieren Sie das Bauteil SM0603 in der Library
SM. Klicken Sie auf Check In...

Libraries — PCB Footprints

Library Folders Schematic Symbols  Schematic Doc Symbols  PCB Footpints  PCB Doc Symbols Pats 3D View  STEP Mode! Folders

[« AT TCURRS 1 ofl [in “C:\Users'\mum'\Documents'\Pulsonix10.5\MasterLibraries

Attribytes... New Library... Report
Contents
Mew Erevien
Edt..
Delete
Hind
Rename...
Copy...
Move...
Import...
Load Tech...
Wigard...
To Dac Sym..
Check In...
Check Out...
e [fro from Vaul)
Uncheck...
Matched: 1 of 161 Refresh
Filter Technology File

[smos03 Mo Pins: Apply |[None]

Clear

O Chedk In as replacement

| Default Next Vault Revisi
ElaUit HextVaLt Revision for existing vault item

Close item after Chedk In
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Erstellen Sie ein neues Part um Vault ltems
hinzuzuftgen:

Klicken Sie im Part Editor auf New und der Dialog 6ffnet
sich.

Library Folders  Schematic Symbols Schematic Doc Symbols  PCB Foctprints  PCB Doc Symbols  Pats 3D View  STEP Model Folders  STEP Models

[T [ sistor pal_[in "C.\Users mumDocuments\Pulsorix 1) 5\lasterlibraries” M
Corterts New Part
[e0aR10T |
4303R102 1K Patt Name: (R 0.25W 10§ | [
4308R-1022.2K
4308R-102 47K Pait Type: (@) MNomal Pat (O PCE Only O Schematics Only Cancel
300103 2k O Connector O Associsted Part
333§Ej g% ‘1’;5 Provide Part Details Now [Huick Part Creation]
4303R102 100K
4308R102220
4308R102470 Desrplio: |
4508%-102 1K
4808%-1021.5K
4608X-1022.2€ NameStern: [ | PnCounc[ |
4508x-1022.7K
4508x-1023.3K PLE View
4508x-102 47K
4508102 10 Footprint: R[]
4808102 10K
450810222 Schematics View
iy EEO——
pre gyl symbetPnComne [ |
480810256 )
4608%-102 68 Symbol < Res [
4508X-102 82
4608%-102 100 Totel Schematics Fins: [ | UngatedPins: [ |
4508x-102 100K
E Dot Dinesre
< o GO
Matched: 748 of 748
Fiter
No. Pins: Aooly Nore]
Clear
Add To Design Add ToComp Bn |1

Vergeben Sie den Part Namen und die Description.
Wahlen Sie den Footprint aus den Sie in die Vault
eingecheckt haben (SM0603 {Vault}).

Wahlen Sie das Schematic Symbol, dass bereits in der
Vault vorhanden ist. Bestatigen Sie mit OK und das Part
wird gedffnet.

MNew Part X
Part Name: |F| 025w 10K, | | 0k I
Part Type: (@) Mormal Pat (O PCB Only () Schematics Only Ea]

(O Connector () Associated Part
Provide Part Details Mow  [Quick Part Creation)

Descrption: |Sulfface Mount Resistor

Part Earnily: | |

PCE View

Footprint: | SMOE03 i aulth

~  Pads

Schematics View

(@ Single Sprmbal () Multiple Gates

Symbol Fin Count; I:I
Symbal | R ault) + PFins
Total Schematics Ping Ungated Pins: l:l

[ Power Pin [ Ground Pin

YT GMND

Flgen Sie Bauteil Attribute im Register Parts and
Attributes hinzu.

mr Eile Edit View |[nsert Setup Tools Window Help

O=dr OQCITMESRIMRNO®

Il-a Attributes

Part Name |Manually Name Parts R 0.25W 10K
3D+ [ attributes | Value 10K
=

Klicken Sie auf File > Check into Vault, um das Part in
die Vault zu laden.

Check Into Vault X

Vault Revision: I:l

| \Bauteil Library\Parts\Vault Demo | Browse...

Name: | R 0.25W 10K

Default Mext Vault Revision

Vault Folder

Chedk In Note

Bauteil erstellt und hochgeladen|

Close item after Check In
[]remove item from local library after Check In

Cancel

Update des Designs mit neuem Bauteil

Wir werden nun den neu erstellten Schaltplan mit dem
neuen Bauteil versehen.

Offnen Sie den Vault Browser, selektieren Sie das
Design und klicken Check Out. Fiigen Sie eine Notiz fur
zum aktuellen Check Out Vorgang hinzu und bestatigen
Sie mit OK.

$tTral Export Vaul Librares

Se
Foider ame— [Revision] B
5

Check Out.

Vault Ttem;
Copy Out

e[St

Uncheck.

o [ Repors.

]
]
ne: [Vadkbeaon |
]
]

Check OutNote

Ve Detae: [ Tl i earbeurg

emo] e

i

7 settngs

a7 Dopenroreat -
o e

—
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Das Design wird nun zur Bearbeitung lokal auf Ihrem
System gespeichert und in Pulsonix gedéffnet. Im Vault
Browser wird es, solange es ausgecheckt ist, einer
anderen Farbe angezeigt.

Vault ftems: 1

Item ID| |Type ‘Fo\der Name |Revm|on |
207 ;!?.cnematic Design[\Das\gn Contentiault Design | Vault Design 11.0 i

ltem Details: |Audit Trail ~ Revision: | <Latest Revision: ~

Item 1D Type Action Date Timestamp Revision [Action Type

207 Hg :Schematic Design 17-12-2020 08:26:35.226 116-12-2020 14:48:17.879:1.0 Moved

207 Hy| :Schematic Design  16-12-2020 14:48:19.044 :16-12-2020 14:48:17.879:1.0 Moved

207 Hy| :Schematic Design | 16-12-2020 14:48:17.879 :16-12-2020 14:48:17.879:1.0 Added (with automatic refer
Ersetzen Sie das Part im 2 faeOnesic e

: : : ) Rotate About
Design, indem Sie es ) ChingeRotation ..
selektieren und rechte u
£ Scale

Maustaste Replace Part 2 o
aUSfUhren E Change Testpoint...

Remove From Net

[ Reload From Library.
B ReplacePart..

[ Save ttems To Library...
) Mext Alternate Part

3 EditPart In Library...
s Edit Symbol In Library...

Klicken Sie auf Change Part und wahlen Sie das neue
Part aus der Vault aus. Bestatigen Sie mit Replace.

B Replace Part *

Replace Thiz:

Part: ~ |

Desc: |Surfface Mount Resistor | Plirig:

Farnily: | |

Foatprint |<An_l,l Footprint> | v |

Replace with:

Pat R 025w 10K | F Crange.

Desc: |Thic:k Film Surface Mount Resistor | Pins:

Farnily: | | Alternate...

Footprint: |<Default Footprint: | w |

“which Components: Fieplace Options:

Loak for components ta replace in: [ keep attibute styles

() whole Design Current Page [ keep attibute pozitions

. ] Keep local attribute val

(®) Selection Only Current Block, Pl Qi u.e vales .
] Replace nets assigned to ungated pins
[ Update predefined nets an symbal pins
[ Update name stem
] Replace gate symbols with defaults
[] Show Report after Replace

Beplace Yiew Report Cancel

Danach kdnnen Sie das Design in die Vault einchecken.

Check Into Wault *

Name: | Vault Design | Vault Ttem ID:
Default Mext Vault Revision Vault Revision:

Vault Folder

\Design ContentiVault Design Browse...

Check In Note

Replace Carbon Film Resistor with Surface Mount Resistor (R 0.25W 10K)

Close item after Ched: In
[Iremove item from local folder after Chedk In

Concel

Begutachten Sie den Stand des
Designs in der Vault

Offnen Sie den Vault Manager -Browser und selektieren
Ihr Design. Stellen Sie die Item Details auf ,Refers To*
und wahlen Sie <Latest Revision>. Jetzt sehen wir, dass
das neue Bauteil Thick Film SMR durch das obsolete
Bauteil (Carbon Film SMR) ersetzt wurde.

temio] _[ype Revision Timestamp B
a7 Schematc Technogy WTechnology Fies W D10 21072017 e szl

i H andscape 10 281073017 04730 584

300 [ Schemichiotie  ibrofies ALandscape A5 g7 3017 108592 113

P an o autei LivraryarisiVatit Damo R 0250 10K 00 916 44 115

Preview OF Pat RO25M 10

escrption=Thick Fim Suface Mourt Resistor

8M®6® 3 [t

3

Info: Jede Revision kann ausgecheckt werden und wird,

falls sie wieder-eingecheckt wird, zur letzten Revision.
Altes Bauteil ausfindig machen:

Wahlen Sie bei ,Refers To" die Revision 1.0 aus.

Selektieren Sie in der Liste das Bauteil Carbon Film
SMR (R 0.25W 5% MCF 10K) > rechte Maustaste >
Show ,Where Used".

ttem Details AR =M1 0 (16122020 14 48.17.879) v

item ID [Type Folder Name Revision | Timestamp

130 2 Pt \Liorary ContentiParts|Vaufi Demo TNa128 o 21-07-2017 17:67.00
13 g Part \Library ContentiPartsiVaufi Demo CpaniTaE 10 S1.07-2017 1767:00
3" g iPart \Library ContentiPartsiVaufi Demo [0 250 BSLCE 0K 110

138 an Pt Library ContenfiParts\Vault Demo N2 Show 'Where Used'

147 (E " Schematic Technology | {Technoioay Fies. Defal Show 'Refers To'

Preview Of:  |Part 'R 0.25W 5% MCF 10K

<Part Famiy>=R 0.25W
Category=Resistor/Carbon Fim
Description=Carbon Film Resistor
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Der Vault Manager springt nun in die ltem Details
~Where used“ des selektierten Parts und zeigt alle
Designs an welche dieses Part verwenden.

136 an Part {\Library Content\Parts\Vault Demo fR 0.25W 5% MCF 10K 1.0

128 an Part :\Library Content\Parts\Vault Demo : R 0.25W 5% MCF 330 1.0

137 an Part :\Library Content\Parts\WVault Demo : RM-065-100K 1.0

ltem Details v Revision: |<Latest Revision> v

Item 1D Type Folder Name Revision | Timestamp

157 Schematic Design :\Design Contenf\LED Display Project : LED Display-3:1.0 21-07-2017 18:08:14.212
158 PCB Design \Design ContentLED Display Project: LED Display-3:1.0 21-07-2017 181122736
207 Schematic Design :\Design ContentVault Design ‘Vault Design :1.0 16-12-2020 14:48:17.879

<Part Family>=R 0.25W
Category=Resistor/Carbon Film
Description=Carbon Film Resistor

Aufgabe: Ersetzen Sie mit ,Replace” das Bauteil in den
Designs in der Liste durch das Bauteil Thick Film
Suface Resistor (R 0.25W 10K) wie in den vorherigen
Schritten.

Erstellen einer Suche in der Vault

Offnen Sie den Vault Manager und klicken den Search
Button.

Search in Vault X
Find: ~ Clear Load.. Save Saveds.. || i
Item ID ~ | |Between | [ 30042020 | and [03-10-2020
O Item ID Equal to
O Item ID Equal to
O <Current User> [show Checked-out State

Sort by ~ | [ Ascending Order

ne

Fillen Sie die Felder mit lhren Suchkriterien aus und
Speichen die Suche mit Save as... als .vfs Datei ab.

|

Footprint Suche ~ Search...

Move...

Diese Suche ist nun im Schnellzugriff fur Suchen im
Vault Manager verfugbar.

Historie in der Vault
Erstellen Sie eine Audit Trail Query:

Offnen Sie den Vault Manager und das Register Audit
Trail. Setzen Sie das Hakchen Filter By, Latest, geben
Sie den Wert 10 in die Box ein und selektieren den radio
Button ,entries®.

Setzen Sie den Haken bei Where mit den Kriterien
»Action Type* ,Equal to“ Added (with automatic
referencing).

7 Vault Manager — Audit Trail

Browser Librariesto Vaut  Designs to Vauk  Audit Tral | Beport Vait Libraries

17122020 081542412 209

16122020 1526:37.768 208

16122020 14:48:17.879 207
072017 09:55:35.143 206 admin Added (with automatic referencing) Schematic Profile C-Landscape [1.0] "Added to Vaul

205 admin Added (with automatic referencing} PCB Profile C-Landscape [1.0] "Added to Vaut”

204 admin Added (with automatic referencing} Schematic Profile B-Landscaps [1.0] "Added to Vaut”

203 admin Added (with automatic referencing} PCB Profile B-Landscape [1.0] "Added to Vaut”

202 admin Added (with automatic referencing} Schematic Profile A-Landscape [1.0] "Added to Vaut”

201 admin Added (with automatic referencing} PCB Profile A-Landscape [1.0] "Added to Vaut”

26072017095532.113 200 admin Added (with automatic referencing) Schematic Profile Ad-Landscape [1.0] "Added to Vaul”

admin Added (with automatic referencing) Part R 0.25W 10K [1.0] "Bautel erstelt und hochgeladen”
admin Added (with automatic referencing} PCB Footprint SMO§02 [1.0] "R-0603 Footprint”

admin Added (with automatic referencing} Schematic Design Vault Design [1.0] *Erster Check In des Vault Desigr

[ Fiter By
[ Latest: Odays Ohous @ entries
(4 Where: | EETERRTR v v ~

Apply,

Es werden folgende Informationen angezeigt:
1. Date Time = Zeitpunkt des Uploads

2. ltem Number = Vault interne Iltem Nummer

3. User = Anwender der Aktion
4. Action = Art z.B. Hinzugefligt
5. Item = z.B. Part, Footprint, Profile

6. Check In Note = Notiz vom Anwender

Technischer Support:

Weitere hilfreiche Dokumente bekommen Sie auf
www.tecnotron-software.de/de/service/fags/

Falls Sie Fragen zur Installation, Anwendung oder
Vorgehensweisen haben stehen wir lhnen gerne zur
Verfligung Uber unsere Supporthotline:

Tel.: +49 8389 9200-402
E-Mail: support@tecnotron.de

Wir bieten regelmafige Pulsonix Schulungen an.
Informationen finden sie unter www.tecnotron-
software.de/de/service/seminare/
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